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Introduction

MastercamMachine Simulation is a safe, cost-effective way of proving out 3-axis, 4-
axis, or 5-axis Mill or Router toolpaths. Machine simulation helps you detect collisions
between your stock, tool, and any machine components before sending any code to
your machine tool. You can use machine simulation to test possible multiaxis fixture
scenarios and find the ideal location for machining a particular job. It is an additional
tool to help youmake clean, efficient, and accurate toolpath programs.

Tutorial Goals
l Introduce you to the machine simulation workspace.

l Illustrate the machine simulation workflow.

l Show the benefits of usingmachine simulation.

l Analyze toolpathmotion withmachine simulation.

l Simulate both 3-axis andmultiaxis toolpaths.

WARNING: Screen colors in the tutorial pictures were modified to enhance
image quality; they may not match your Mastercam settings or the tutorial
results. These color differences do not affect the lesson or your results.

Estimated time to complete this tutorial: 2 hours

General Tutorial Requirements
All Mastercam 2018 tutorials have the following general requirements:

Introduction to Machine Simulation — Introduction



l Youmust be comfortable using the Windows® operation system.

l The tutorials cannot be used with Mastercam Demo/Home Learning Edition.
The Demo/HLE file format (emcam) is different fromMastercam (mcam), and
basic Mastercam functions, such as file conversions and posting, are unavail-
able.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's
skills. We recommend that you complete them in order.

l Additional files may accompany a tutorial. Unless the tutorial provides specific
instructions on where to place these files, store them in a folder that can be
access from the Mastercam 2018 workstation, either with the tutorial or in any
location that you prefer.

l You will need an internet connection to view videos that are referenced in the
tutorials. All videos can be found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a
default metric or English configuration. The tutorial provides instructions for
loading the appropriate configuration file.

Machine Simulation Tutorial Requirements
In order to runmachine simulation, youmust have the following:

l MastercamMill or Router

l A Mastercam part file with at least one toolpath and a surface or solid model
of the workpiece.

The following toolpaths or functions are not currently supported in Machine Sim-
ulation:

l Lathe

l Wire

l Drill 5-axis

Introduction to Machine Simulation — Introduction
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l Circle Mill 5-axis

l Translate, Rotate, or Mirror (Transform)

l Block Drill

l Axis substitution

l Aggregate head

l Non-motion FBM preparation operations

CAUTION: Machine Simulation uses the NCI data fromMastercam to sim-
ulate your toolpaths. It is not a G-code simulation product. Also, Machine
Simulation does not use the machine definition associated with each
toolpath. This allows you to choose any available machine model and quickly
simulation your toolpath.

Introduction to Machine Simulation — Introduction
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Welcome to Machine Simulation

This chapter introduces you to the Machine Simulation interface, including
selecting a machine for simulation, running a simulation, and selecting
options for displaying your part.

Lesson Goals
l Starting Machine Simulation

l Navigating through the Machine Simulation interface

l Selecting a different machine

1



Exercise 1: Opening the part file
1. Start Mastercam using your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the
System Configuration dialog box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-
down list.

d. ClickOK.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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3. Open the SWARF part file that was provided with this tutorial.

Note: Machine simulation requires a Mastercam file with solids and/or surface
geometry.

4. Select Levels located with the Toolpaths Manager tab to open the Levels Man-
ager.

If the Levels Manager is not displayed, select Levels on the View tab to toggle
the display.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



Notice that the part is located on the main level and the fixture is on level 6.

Exercise 2: Preparing the Simulation Environment
1. Select the dialog box launcher in the Machine Simulation group on the

Machine tab.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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The Machine Simulation dialog box displays.

2. To see all the machine configurations installed with Mastercam, select the
Machine drop-down list at the top of the dialog box.

Mastercam includes models of the most popular mill and router machines in
the industry, including examples of all three major 5-axis machine groups.

l Table/Table

l Table/Head

l Head/Head

The machine names are abbreviated to include information about the
configuration:

Introduction to Machine Simulation —1: Welcome to Machine Simulation



3. Select A6_5XRHINO_VMCHTBA from the machine list.

4. Click the Geometry drop-down list.

By default, Machine Simulation loads all visible surface and solid geometry as
the workpiece, but you can control this by selecting one of these options.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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5. Select All elements from the list.

6. Click the Fixture drop-down list. Select From Level and select level 6.

The options are similar to the Geometry drop-down list.

7. Enter 0.3 for the Simulation tolerance.

This parameter sets the tolerance for detecting collisions between the part or
stock and the machine.

8. SelectUse Mastercam Settings.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



You can configure Machine Simulation’s display colors and shortcut keys inde-
pendent of the Mastercam environment. Selecting this option reads the
Mastercam configuration file and sets the colors and shortcut keys to match
Mastercam.

9. To go directly to the simulation, click Simulate at the bottom of the dialog box.

Mastercam stores the simulation startup settings in the part file when you
save the file after running simulation. The next time you open this file, you can
go directly to running the simulation.

The simulation interface lies on top of the Mastercam interface and shows the
part positioned in the machine.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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If you cannot see your part, clickWorkpiece in the Simulation tab to display it.
If your display includes additional windows, choose View, Reset to match the
picture shown above.

10. Select the following Docking Panes from the View tab:

a. Move List (If not already displayed)

b. Progress (If not already displayed)

c. Analysis (Toolpath)

d. Machine

e. Report

Introduction to Machine Simulation —1: Welcome to Machine Simulation



All of these windows will be used during the tutorial. The window layout should
now look like the following image:

Youmay have to dock single tabs with the other tabs, as it may appear above
the others.

Exercise 3: Viewing the Simulation
Machine Simulation provides several options for viewing and analyzing your toolpath
motion in your machine. The VCR-style controls and the slider bar are located in the
Simulation tab.

Introduction to Machine Simulation —1: Welcome to Machine Simulation

18



19

1. Select the Simulation tab.

2. Move the indicator to the middle of the slider bar.

l Moving the slider bar to the left side decreases the speed of the sim-
ulation, but increases the detail of the simulation.

l Moving the slider bar to the right side increases the speed of the sim-
ulation, but decreases the detail of the simulation. The simulation skips
an increasing number of steps and if a collision occurs in the skipped
steps, it is still reported.

3. Click Run to begin the simulation.

The simulation proceeds step by step through the toolpath. Notice that the pro-
gress bar along the bottom of the screen and the Move List in the upper right
corner both update as the simulation continues.

4. An error message will display, notifying you of a collision. Click Yes to continue
running the simulation.

5. Click the Report tab.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



After simulation is complete, Report tab lists events that happened during sim-
ulation. In this exercise, the report indicates that the B and A axes collided.
Also, Value underflow X tells you that the X axis position was below the axis
limits for the indicated tool moves.

6. Click on Collision between B1 and A3 in the Report tab andMachine Sim-
ulation jumps to where the problem occurs. The two axes that collide display in
red.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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To lookmore closely at the motion, move your mouse to the workpiece center
and roll your mouse wheel to zoom in.

7. Click theMove List tab at the bottom of the report window to display the list of
coordinates for each toolpathmove.

8. In the Move List, scroll to line 213, which is where the collision begins, and
press the down arrow on your keyboard to step through the next several
moves in the toolpath.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



You can also move the slider on the right side of the Move List up and down to
move through the tool motion.

9. Move the slider on the Progress bar at the bottom of the screen all the way to
the left to start at the beginning of the toolpath.

10. Click the arrow belowMachine in the Simulation tab and selectWork-
piece/Stock to show only the tool and the workpiece.

This focus optionmoves the tool around a stationary workpiece.

11. Scroll the mouse wheel to zoom out.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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12. Right-click in the graphics window and selectOther Views, Left to rotate the
part to the left view.

Machine Simulation includes many standardMastercam views.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



13. Click and hold the left mouse button while moving the cursor down in the sim-
ulation window. This action rotates the part down and allows you to see the
toolpathmore clearly.

14. Click Run to play the simulation again.

The workpiece focus mode lets you concentrate on just the tool motion.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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15. Set the focus back toMachine and set the view to Isometric.

16. Click Fit to center the machine in the simulation window.

17. Exit the Machine Simulation and return to the mainMastercam screen.

This exercise includes just a few of the possible viewing options in Machine Sim-
ulation. You try more in the following chapters.

Introduction to Machine Simulation —1: Welcome to Machine Simulation



Exercise 4: Selecting a Different Machine
One of the benefits of Machine Simulation is being able to prove out a program
without usingmachine time. Finding issues early can save you time andmoney. In this
exercise, you select a different machine for simulation based on collisions and under-
flow issues found in the previous exercise.

1. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

2. Select the 8_5XDMU_VMCTTBCmachine from theMachine drop-down list.

3. Enter 0.3 for the Simulation tolerance, if necessary.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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4. Click Simulate at the bottom of the dialog box to return to simulation.

5. Increase the simulation speed with the slider (as shown in Exercise 2) and then
click Run.

6. When the simulation is complete, click the Report tab to see the results. No col-
lisions are reported.

7. Exit Machine Simulation and return to the mainMastercam screen.

Testing your parts in different positions and on different machines is an integral part
of the machine simulation process. The next chapter goes into more detail on this pro-
cess, including backplot andmaterial removal verification as part of the recom-
mended workflow.

Introduction to Machine Simulation —1: Welcome to Machine Simulation
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Using the Machine Simulation Work-

flow

Now that you have a basic idea of howMachine Simulation works, this lesson
goes into more detail on howMachine Simulation can fit into your machining
process. AddingMachine Simulation to your workflow helps you choose the
best setup for each part andmachine.

Lesson Goals
l Backplotting toolpaths to analyze toolpathmotion

l Simulating toolpaths to check fixturing andmachine motion

l Verifying toolpaths to confirmmaterial removal

2



Exercise 1: Backplotting the Toolpaths
The first step is to check the quality of the toolpathmotion usingMastercam’s Back-
plot function, which lets you closely examine the tool motion to make sure it meets
your needs.

1. FromMastercam, choose File,Open and open the part file, VISERING,
provided with this tutorial.

This part is configured in inches, so you are prompted to switch fromMetric to
English. Choose All settings and clickOK to continue.

2. If necessary, press [Alt+S] to shade the part.

The toolpaths included in the part file machine the green faces on the part.
This part is ideal for 5-axis toolpaths, because you can potentially machine the
whole part in one setup. This would be difficult on a 3-axis machine.

3. Use the Levels Manager to display the vise on Level 2.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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This is just one possible fixturing solution for this part. In every case, youmust
decide how to hold the part in the machine.

4. Select all the toolpaths in the Toolpaths Manager by selecting Toolpath

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



Group-1, and click Backplot selected operations.

The Backplot dialog box displays.

5. ClickOptions on the Backplot dialog box to adjust the display settings before
running the backplot.

6. Deselect the following parameters on the Backplot Options dialog box:

a. Simulate Axis Substitution

b. Simulate Rotary Axis

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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c. Display vectors

Turning these options off keeps the part stationary in the graphics window and
moves the tool around the part.

7. ClickOK to close the Backplot Options dialog box.

8. Turn onDisplay tool andDisplay holder on the Backplot dialog box to see
the tool and holder during the backplot.

9. Click Play on the Backplot VCR bar to run the backplot.

As the backplot progresses, watch the tool and holder for any collisions with
the part or fixture. Rotate the part or zoom out if necessary to get a better view
of the tool motion.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



10. ClickOK on the Backplot dialog box when the backplot is complete.

The tool motion looks good so far. The next step is to simulate the motion on a
machine.

Exercise 2: Preparing and Simulating the Toolpaths
Backplotting toolpaths is a good initial step to check the tool motion, but it can only dis-
play the tool and holder. It cannot show you how the rest of the machine components
move around the part. Machine Simulation lets you visualize how all parts of the
machine move when processing the toolpaths.

Before you begin the next exercise, you add a newmachine to select for simulation.
This procedure is helpful if you create a newmachine that matches one in your shop.
For more information on additional machines for simulation, please contact your local
Mastercam Reseller.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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1. Copy the HERMLE800 folder provided with this tutorial to the following loc-
ation:

C:\Users\Public\Public Documents\shared
Mcam2018\MachineSimulation\MachSim

Each folder represents a machine and contains the files needed to simulate
that machine:

a. XML file with the kinematic machine structure

b. GIF file that displays in the startup settings dialog box

c. STL models that represent the machine’s physical components

2. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

3. Set the following parameters:

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



a. Click theMachine drop-down list and select the Hermle800machine
that now appears in the list.

b. Set Geometry to From Level and 5.

c. Set Position to Translation in XYZ.

d. Set Y to 2.5 and Z to -3.

e. Select From Level and select level 2.

f. Enter 0.012 for the Simulation tolerance.

4. Click Simulate to display the part in the machine.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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If necessary, setMachine Housing to Show and set Simulation to focus on the
Machine.

5. Click Isometric and Fit to display the entire machine in the simulation window.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



Exercise 3: Viewing the Simulation
1. Click Run to begin the simulation.

2. Click Yes in the Gouge/Collision dialog box. There will be four collisions total.

3. The Report tab displays collisions in operations 2 and 4.

4. Click on the first collision in the Report tab to jump to that toolpath section.

5. Zoom in to the collision by scrolling your mouse wheel.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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The fixture is colliding with a section of the tool spindle.

6. To get a better view of what components are colliding, click theMachine tab.

7. Right-click the Geometry5 component under the Z axis and choose Trans-
parent.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



You can now see through the spindle housing to get a better view of the col-
lision.

8. Right-click the Geometry7 component and choose Transparent to provide
evenmore visibility.

9. Select the Report tab to return to the operation list.

10. Click on the first collision in Operation 4.

11. In the Simulation tab, click the drop-down list belowMachine Housing and
selectHide to simplify the machine display.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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12. Right-click in the graphics view and selectOther Views, Right to move to the
right side view.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



This position gives you a better view of the collision between the spindle and
the fixture.

13. Select theMove List tab.

14. On the side of theMove List, pull the slider bar down to step through the two
collisions in this operation.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow

42



43

15. Exit Machine Simulation when you are satisfied and return to Mastercam.

Exercise 4: Adjusting the Fixture
By usingMachine Simulation, you can see that this fixture is not optimal for the selec-
tedmachine. Machine Simulationmakes it easy to try different types of fixturing and
avoid costly mistakes while running the machine.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



1. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

2. Set the fixture to Level 7.

3. Click Simulate.

4. SetMachine Housing to Show.

5. Click Isometric and Fit to display the entire machine in the simulation window.

6. Click Run to simulate the toolpaths.

The new, smaller fixture causes no collisions.

7. Exit Machine Simulation when you are satisfied to return to the mainMaster-
cam screen.

Exercise 5: Verifying Material Removal
Now that you feel confident running the toolpaths on this machine, the final step is to
check the stock’s shape after running the toolpaths. Machine Simulation includes the
necessary material removal verification tools.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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1. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

2. Set the stock to From Level and set it to level 4.

3. Click Simulate.

Because you selected stock in the simulation settings, machine simulation auto-
matically opens inmaterial removal mode.

4. Click Run to simulate the toolpaths.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow



You can see the tool actually removingmaterial from the part as it moves
through the toolpaths.

Flute collisions are reported on two of the operations. One way to fix this issue
would be to return to Mastercam and extend the tool shank length for the tool
that is used by these operations.

5. Exit Machine Simulation when you are satisfied to return to the mainMaster-
cam screen.

The final workflow step is to cut the part on the actual machine. Since you have tested
this machining strategy in several ways, you can feel confident that the part will cut
correctly

WARNING: While Machine Simulation lets you experiment withmultiple cut-
ting strategies and fixture combinations without using valuable machine
time, there is no substitute for the first run of a part on a machine. Always
be alert and cautious when running a part for the first time on a real
machine.

The next chapter provides information about additional toolpath analysis in machine
simulation.

Introduction to Machine Simulation —2: Using theMachine Simulation Workflow
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Toolpath Analysis

Mastercam’s Machine Simulation provides several tools for evaluating your
toolpath efficiency and accuracy. These tools can help you determine the
best cutting strategy, fixturing, and positioning for your multiaxis parts.

Lesson Goals
l Inspecting part positioning

l Analyzing tool motion

l Adjusting analysis options

3



Exercise 1: Analyzing Before Fixturing
Machine Simulation’s toolpath analysis can provide useful information even before
you select a method for holding your part in your machine. You can see if the tool
motion works in a virtual environment before using valuable machine time.

1. FromMastercam, choose File,Open. Open the part file, CURVE_5X, provided
with this tutorial.

This part is configured inmetric units, so you are prompted to switch from Eng-
lish to Metric. Choose All settings and clickOK to continue.

2. Click Run on theMachine tab.

Introduction to Machine Simulation —3: Toolpath Analysis
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The part file has a simulationmachine and position already assigned.

3. Click Run to begin the simulation.

4. Select the Report tab.

Introduction to Machine Simulation —3: Toolpath Analysis



Machine Simulation reports a value underflow in the Z axis. This message
means that the Z axis position was below the axis limits for the indicated tool
moves.

5. Click on the issue in the Report tab andMachine Simulation jumps to where the
problem occurs.

6. Zoom in to the part and click Right on the Simulation tab to get a clearer
view.

7. Step through the toolpath’s problem section.

Before you even select a fixture for the part, you can see that the part has prob-
lems on this machine. Youmay need to select a different machine in your shop
or position the part closer to the table to avoid the reported issues.

8. Click Exit to close Machine Simulation.

Introduction to Machine Simulation —3: Toolpath Analysis
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Exercise 2: Analyzing Before Machine Selection
Nomatter what machine you select, Machine Simulation includes analysis tools that
provide additional details on your toolpaths. These details may affect what machine
you select for your part.

1. FromMastercam, choose File,Open. Open the part file, SPLIT_IMPELLER,
provided with this tutorial.

2. Select the second toolpath in the Toolpaths Manager.

Introduction to Machine Simulation —3: Toolpath Analysis



Machine Simulation only displays the selected toolpaths.

3. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

The basic 5AxHeadHeadmachine is selected by default.

4. Enter 0.3 for the Simulation tolerance.

5. Click Simulate to display the part. No machine displays.

6. Click Run to watch the toolpathmotion on the part.

Introduction to Machine Simulation —3: Toolpath Analysis

52



53

If the toolpath is not displayed, click Toolpath in the Visibility section of the Sim-
ulation tab.

7. To see the tool motionmore clearly, click theMachine tab, right-click on the
workpiece in the tree control, and choose Hide.

Introduction to Machine Simulation —3: Toolpath Analysis



8. Click the Analysis tab.

This tab includes many options for closely inspecting your toolpathmotion.

9. Select B Axis Reversal from the drop-down list at the top of the tab.

This analysis option changes the toolpath color every time the rotation axis
changes direction. The color changes can help you identify areas where dir-
ection changes could impact your surface quality.

10. Rotate the part and zoom in if necessary to get a better view of the color
changes.

Introduction to Machine Simulation —3: Toolpath Analysis
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According to the color key in the Analysis tab:

l Blue: Positive axis directionmoves

l Green: Negative axis directionmoves

l Red: Axis direction reversal

The red areas could create patternmarks on your surface if you are running
an older machine. Youmay be able to work around these areas by adjusting
the part in the machine.

11. To change the color for negative axis directionmoves andmake them easier to

Introduction to Machine Simulation —3: Toolpath Analysis



see, double-click the green square to display the Colors dialog box.

12. Select the yellow color from the Colors dialog box and clickOK.

13. Click Refresh on the Analysis tab to update the colors in the simulation win-
dow.

Introduction to Machine Simulation —3: Toolpath Analysis
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The new color provides a better contrast andmakes it easier to see the dir-
ection changes.

14. Select Sequence from the drop-down list at the top of the Analysis tab.

This analysis colorizes the toolpath in a “hot to cold” gradient, which identifies
the following attributes:

Introduction to Machine Simulation —3: Toolpath Analysis



l Machining start and end points

l Cuttingmethod (zigzag or one way)

l Cut order (inside to outside, outside to inside)

The default colorization uses ten gradients, starting with red at the beginning
of the toolpath and ending with blue. You can see where the toolpath begins
and ends and that it moves in a zigzag pattern.

You can addmore gradients by clicking the Add button at the top of the Ana-
lysis dialog box.

15. Click Exit to return to the mainMastercam screen.

Introduction to Machine Simulation —3: Toolpath Analysis
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These analysis options help you adjust your toolpaths to be more efficient and effect-
ive. To learnmore about analysis options and about the Machine Simulation in gen-
eral, press [F1] while in the Machine Simulation window to bring up the Mastercam
Help.

Although youmight think that Machine Simulation is mainly for Multiaxis toolpaths, the
following chapter demonstrates the benefits for 3-axis toolpaths as well.

Introduction to Machine Simulation —3: Toolpath Analysis
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Machine Simulation for 3-Axis

Toolpaths

Whether you’re creating 3-axis or 5-axis toolpaths for your parts, Machine
Simulation lets you see your part beingmachined virtually so you can optim-
ize your toolpathmotion. Even 3-axis toolpaths can benefit from the stock
removal and fixture testing that Machine Simulation offers.

Lesson Goals
l Using an STL file to simulate stock removal

l Testing fixturing options in Machine Simulation

l Creating a presentation of simulation results

4



Exercise 1: Simulating Stock Removal
Besides simulatingmachine motion, Machine Simulation can show stock removal to
confirm your final part shape.

1. From the Mastercammenu, choose File,Open. Open the part file, POCKET_
VISE, provided with this tutorial.

This part is configured in inches, so you are prompted to switch fromMetric to
English. Choose All settings and clickOK to continue.

2. Use the Levels Manager to display the vise on level 1000, the jaw on level
1001, and the stop on level 1002.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths
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3. Fit the part and fixture in the graphics window.

4. Select all the toolpaths in the Toolpaths Manager.

5. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

6. Machine Simulation is already set to use a 3-axis vertical machining center.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths



7. Click Simulate to display the part in the machine.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths
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If you don’t see the workpiece, click the drop-down arrow below theWorkpiece
button and select Show.

8. Confirm that Toolpath is selected to display the tool motion.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths



9. Zoom into the part and click Run to view the simulation.

10. When the simulation is complete, click Exit to return to the mainMastercam
screen.

Now that you’ve seen the basic tool motion, you can adjust the simulation envir-
onment to check stock removal and test fixturing.

Exercise 2: Adding a Fixture and Stock
1. Select the dialog box launcher in the Machine Simulation group on the

Machine tab.

2. Click the Fixture drop-down list and select Selected elements.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths
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3. Click the button to the right of the Fixture drop-down list.

4. Select the vise, jaw, and stop in the graphics window and press [Enter] to
return to the dialog box.

5. Click the Stock drop-down list and select Load STL file.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths



6. Click the button to the right of the Stock drop-down list and select POCKET_
STOCK.STL that was provided with this tutorial.

7. Click Simulate.

8. Hide theWorkpiece and the Toolpath.

9. Zoom in on the part in the machine. The STL file displays as blank stock.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths
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10. Click Run to view the material removal.

Introduction to Machine Simulation —4: Machine Simulation for 3-Axis Toolpaths



11. Click Exit to return to the mainMastercam screen.

Exercise 3: Simulating with Different Fixtures
As you’ve seen with 5-axis toolpaths, usingMachine Simulation to test out different fix-
tures can save you valuable time andmoney. You can do the same with 3-axis
toolpaths.

1. FromMastercam, choose File,Open. Open the part file, PLATE, provided with
this tutorial.

2. Press [Alt+S] to shade the part, if necessary.
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3. Use the Levels Manager to display the vise on level 999.

4. Fit the part and fixture in the graphics window.
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5. Select all the toolpaths in the Toolpaths Manager except the FBM Mill oper-
ation.
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.

Note: Machine Simulation does not support non-motion FBM preparation oper-
ations.

6. Select the dialog box launcher in the Machine Simulation group on the
Machine tab.

7. Use the following parameters on the Simulation tab:

a. Select 1_3AXGEN_VMC from the Machine drop-down list.

b. Select From Level from the Fixture drop-down list and select 999.

c. SelectUse Mastercam stock definition from the Stock drop-down list.
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d. Enter 0.012 for the Simulation tolerance.

8. Click Simulate to display the part in the machine.

9. Use the following buttons on the toolbar to make it easier to see the toolpaths
and stock removal:

a. Click Toolpath on the Simulation tab to display the tool motion.

b. Confirm that theWorkpiece is hidden.
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c. Confirm that the Stock is displayed.

d. Click Current Op. This option displays one toolpath at a time using the
color assigned to that operation.

e. Click Follow. This option displays the path that has beenmachined.
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10. Zoom in on the part and click Run to view the simulation.

11. When the simulation is complete, click Exit to return to the mainMastercam
screen.
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Conclusion

Congratulations! You have completed the Introduction to Machine Simulation tutorial!
Now that you have mastered the skills in this tutorial, explore Mastercam's other fea-
tures and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being
constantly developed, and we will addmore as we complete them. Visit our website,
or selectHelp, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selectingHelp, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help withmost ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is openMonday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
site, or selectHelp, Tutorials fromMastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam trainingmaterials. Take

Introduction to Machine Simulation —Conclusion

mailto:support@mastercam.com?subject=Technical Support


advantage of more than 180 videos to master skills at your own pace and help
prepare for Mastercam Certification. For more information onMastercam
University, please contact your AuthorizedMastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at www.-
mastercam.com. For tech tips and the latest Mastercam news, follow us on
Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search for
information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.
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